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Technical Report

Abstract

Smart munitions have the ability to control flight trajectory as they reach their targets. Although this is feasible
for large munitions such as smart bombs and guided missiles, it is considerably more difficult for small-caliber
munitions such as sniper rounds. Sniper rounds that can control flight trajectory have the potential to have
benefits such as reducing civilian casualties in populated areas or hostage situations, rejecting disturbances
such as wind, and decreasing bullet drop. These all reduce the calculations needed for a sniper to aim. Current
research and control of small-caliber smart munitions, or smart bullets, require physically despinning the
bullet. An approach for controlling the flight of bullets by allowing them to spin with a solid-state, high-
frequency actuator to engage a control surface to modify its flight trajectory is possible. Both spoilers and
Gurney flaps can be used to realize a “walking the precession” trajectory control. A smart actuator for spoiler
deployment has been designed. The solid-state aspect is achieved using a piezoelectric stack, in which its small
deflection can be mechanically amplified via a compliant structure. Using results from preliminary force
predictions through CFD analysis, an actuated spoiler configuration and design requirements were determined.
Design methods using ball and stick models for kinematic structures, comparing torsional stiffnesses, utilizing
a dual amplification system for the compliant structure, and structural and piezoelectric FEA in ANSYS
Workbench are discussed.

Nomenclature
for = blocked force
8o = free displacement
dss = piezoelectric strain coefficient along polarization direction
sk = compliance of piezoelectric material along polarization direction under constant electric field
Vsiack = applied voltage for piezoelectric stack
Vywur = adjusted applied voltage for ANSYS piezoelectric bulk stack
tp = individual piezoceramic plate thickness
Lq = length of piezoelectric stack actuator along polarization direction
A, = piezoelectric stack cross-sectional area
04 = design link length for kinematic or compliant structure
6 = idle (initial) design angle for kinematic or compliant structure
e’ = engaged (final) design angle for kinematic or compliant structure

K = torsional stiffness

E = Young’s modulus

I = area moment of inertia

l = length of flexure or more compliant link

Introduction

Controlling the flight trajectory of small-caliber munitions allows for tracking moving targets and rejecting
disturbances such as wind. Smart bullets can have the potential of stabilizing flight and ensuring that only the
HVT (High Value Target) is hit, reducing collateral damage. Snipers at long ranges of over 1.25 km may become
more efficient when relying on such a technology. The rifling of barrels already allows for aerodynamic stability
and accuracy through gyroscopic spin stabilization, but the bullet can always be subjected to disturbances or
have a chance of missing a moving target. Kogan and Garcia proposed an actuation control scheme that does
not require the munition to be physically despun. Their precession synchronized roll-based control (PSRBC)
method controls the nutation and precession, both of which are slower than the spin rate of the bullet. This
“walking the precession” allows the actuation bandwidth to be at the spin rate of the bullet rather than an order
of magnitude higher if using roll-based control. They suggested that a control surface such as a spoiler or a
Gurney flap engaged once per revolution can be used to control the flight trajectory without modifying the
external geometry of a 0.50 caliber bullet. The spoiler or flap can cause an asymmetric drag on the bullet,
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creating a moment about the bullet’s center of gravity which then causes the bullet to rotate towards the
desired direction.

Maintaining the small size of the 0.50 caliber bullet adds challenges to smart bullet design. Smart actuators,
which utilize smart materials, can reduce the complexity of mechanical systems. Smart materials such as
piezoelectric materials, shape memory alloys, or electroactive polymer materials exhibit coupling and convert
energy between multiple physical domains. For the above materials, piezoelectric materials and electroactive
polymer materials convert between the mechanical and electrical domains, while shape memory alloys convert
between the thermal and mechanical domains. Since the bullet in question spins at 2.5 kHz, piezoelectric
ceramics are used for the actuator design. Its response speed, stiffness, and stress output are among the highest
of the known smart materials and therefore makes it the ideal candidate for this type of smart bullet. However,
piezoelectric materials have a limited strain generation of approximately 0.1%. This small deflection can be
mechanically amplified by acting against a compliant structure, resulting in a solid-state aspect that eliminates
the need for moving parts such as hinges. The elastic properties of a compliant structure allows the actuator to
return to the original disengaged state without expending more energy. This report discusses the design of an
actuator engaging the spoiler for a 0.50 caliber BMG M33 round. Its dimensions are shown in Figure 1 with
possible deployments shown in Figure 2.
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Figure 1: Dimensions for a 0.50 caliber M33 round [McCoy].

Figure 2: Possible deployments for 0.50-caliber smart bullet. Left: Gurney flap. Right: Spoiler.

Preliminary Aerodynamic Analysis

Preliminary three-dimensional CFD simulations using ANSYS Fluent were done by Jonathan Mohr in the fall of
2013 to determine the potential aerodynamic forces acting on an engaged smart bullet traveling at Mach 2.653.
he simulations assumed the bullet was non-spinning so that the results could be confirmed by wind tunnel
testing. The results comparing the clean (unengaged) bullet and the engaged spoiler are shown in Table 1.



Table 1: Preliminary CFD Results

Configuration Clean Bullet ?Er;?r};rirgligysﬁg;lgr @ meur;:gl(l):}llarlgent)
Drag Coefficient 0.354 0.370 0.377
Lift Coefficient 0.00300 -0.0688 -0.0631
Coefficient of Moment 9.52E-05 -7.91E-04 -7.83E-05
Total Drag (N) 23.262 27.184 25.890
Drag on Control Surface (N) N/A 2.674 2.131
Total Lift (N) 0.198 -5.0586 -4.331
Total Moment (N-m) 0.00630 -0.0581 -0.00540

The deployment distance is defined as the perpendicular distance from the back edge of the spoiler to the
surface of the bullet. For the Gurney flap, this is defined as the distance from the top of the flap to the bullet
jacket surface. For a spoiler that is 5 mm long, this translates into a deflection angle of 23.6° However, in this
report, this will be referred to as the “2 mm deployment” requirement. Because of the greater moment induced
by the spoiler, the design of a smart actuator exploring the deployment of a spoiler is explored in this report.

Piezoelectric Considerations

The two most important characteristics of a piezoelectric stack are the blocking force and the free
displacement. The blocked force (Equation 1) is the force required for pushing back a fully energized
piezoelectric actuator to zero displacement, and the free displacement (Equation 2) is the displacement
achieved by an engaged actuator without working against any external load.

. d3345V
Equation 1 for = ==
sEt,
. dasl
Equation 2 8y = %V
P

Above, the intrinsic properties d5; and s£; are important design considerations. A higher d55 results in a higher
piezoelectric stack strain at a given voltage, and a lower compliance (or a higher stiffness) results in a higher
blocked force. These ultimately result in a greater deflection of the spoiler. For demonstration purposes of
actuator design, a non-custom piezoelectric 5 mm x 5 mm x 36 mm P-885.91 piezoelectric stack actuator with
PIC255 piezoceramic plates from Physik Instrumente (PI) was modeled in ANSYS Workbench. Although the
stack can be modeled with its individual plates, it is easier and equivalent to model the stack as one solid
rectangular block of the same piezoelectric material with adjusted voltage conditions. Equation 3 is used for
this adjustment.

. L3V
Equation 3 Vot = 3;—“‘”‘
14

It should be noted that for the P-885.91 stack actuator, the length was 36 mm and the thickness of the plates
was 0.05 mm.

Table 2. P-885.91 (PIC255 material) piezoelectric stack ANSYS model results.

ANSYS Specifications Percent error (%)
Blocked Force (N) 937 950 -1.4
Free Displacement (pum) 28 38 -26




The results in Table 2 show that the resulting design will be conservative. Of course, the material properties
can be adjusted to better fit the specifications, but it was decided to keep the current numbers as they were
given and remain conservative. In order to convert the small stack deflection into a 2 mm flap deflection,
mechanical amplification must be used.

Compliant Structure Considerations and FEA

The mechanical amplification is achieved through a compliant structure. Figure 3 shows an example topology
of the structure. The balls in the ball and stick model represent the compliant flexure hinges while the sticks
represent the more rigid parts of the structure. The dotted rectangle represents the piezoelectric stack, and the
direction of the free displacement is aligned with the negative or positive of the poling direction. This topology
was chosen due to the sizes of the bullet and the piezoelectric stack actuator as well and the location of the
spoiler on the bullet. The extension of the piezoelectric stack translates to an outward motion of the center
links. The resulting mechanical amplification due to the bow-tie structure can be used to gain a lever-like
mechanical advantage that will engage the spoiler.

Figure 3: Compliant structure topology. Left: Idle. Right: Engaged. Bottom: Engaged bow-tie alone.

The engaged topology of a symmetric bow-tie structure (I; = [, = land 8; = 6, = 6) can be found by idealizing
it as a kinematic structure, shown in Figure 3. In a kinematic structure, the hinges are freely rotating links
while the lines are completely rigid. The equations that describe the horizontal and vertical displacement of
the model are

Equation 4 % = {(sin@' —sin 0)

Equation 5 Ay = £(cos 8 —cos 6")



For the kinematic structure, the horizontal displacement is assumed to be the free displacement. Solving for
the vertical displacement after eliminating 8’ by distributing, rearranging the terms, squaring the equations,
and adding them together gives

Equation 6 Ay = ;JM’Z sin?20 —8y(4€cos O +8,) +£sinf

The amplification ratio is the output divided by the input, or

4y 47 SInZ0-8q(4 £ cos 0+8)+sin
S0 8o

Equation 7 a=

It is important to note that the dimensions of the top and bottom center links have no effect on the output of
the kinematic structure. However, for an actual compliant structure, the dimensions will affect the torsional
stiffness of the bow-tie structure. Given the geometric constraints of the piezoelectric stack and the bullet, a
desired length for the angled links can be chosen, and the optimal initial angle can be found (Equation 8).

-1 %0

Equation 8 Oopt = COS ",

For the pm scale of the free displacement and the mm scale of the angled links, 6,,, generally results in an
angle that is slightly lower than 90°.

The model finally used for this project was an asymmetric bow-tie due to the geometric constraints of the bullet
and desired placement of the lever arm. Through some experiments in ANSYS, asymmetric bow-ties were found
to have marginally better outputs. The equations that describe the general asymmetric bow-tie structure are

Equation 9 8o = £,(sin 0] —sin0;) + £,(sin6,’ — sin 6,)
Equation 10 Ay = 4,(cos 0, —cos 0;) = ¥,(cos 8, — cos 63)
Equation 11 0, = cos™! (j—l cos 91)

2
Equation 12 0, =cos™! (j—l cos 91')

2

The symbolic solution for the optimal design angle 6, ,,,,; is too long for this report or the Appendix and showing
it will have no practical value, but it was also generally found to be slightly lower than 90° for the desired
lengths. 89° was chosen for manufacturing reasons and to lower the chance of buckling. Theoretically, optimal
lengths can be found, but this would only change the optimal angle. Therefore, only the optimal angle was
needed. This characteristic was used in designing the actuator.

Traditional mechanical structures achieve compliance by connecting stiff parts to hinges, whereas compliant
structures achieve this by using flexible parts. The flexible areas of the structure bend when a load is
introduced. The flexibility of the configuration is affected by:

1. Material properties,
2. Geometry, and
3. Loading and boundary conditions.



Generally, a high strength to Young’s modulus ratio is desired. A low Young’s modulus results in greater
deflections while a high strength ensures that the structure will not fail. The geometry of the structure is a main
factor in deciding which parts are flexible and which parts are rigid. In most cases, it is desired for the flexible
links to be much smaller in length and have cross-sections with smaller area moments of inertia in comparison
to the more rigid links. The thinner the flexure is in one direction, the greater the deflection in that direction.
However, the fatigue strength or the endurance limit is highly important when designing the smart bullet
actuator as the high actuation bandwidths may result in fatigue failure. Therefore, spring steel was chosen for
the material used to design the compliant mechanism. Although it has a nominal tensile yield strength of 1500
MPa, the nominal fatigue strength of 650 MPa was used as the limiting design criteria for the actuator.
However, structural steel in ANSYS was used for modeling due to its readily available properties. Since the two
have a very similar Young’s modulus, this was deemed acceptable. The area moment of inertia of the flexure
hinges were designed to be small enough to allow greater deflections but not exceed the fatigue strength,
confirmed through finite element analysis (FEA).

Torsional stiffnesses of the flexures and the more rigid links were adjusted to help give the desired effect by
adjusting the lengths. The stiffnesses were crucial design parameters to consider for the lower, bow-tie
amplification system and the upper lever-arm-based amplification system. Equation 13 below was used to
make design decisions.

Equation 13 K=-—

The bow-tie structure was considered the primary amplification system as it directly translated the
piezoelectric actuator’s displacement into an amplified output in a different direction, while the upper
amplification system translated the bow-tie structure’s output into the spoiler displacement. In order to
counteract the opposing forces from the upper amplification system, the torsional stiffnesses throughout the
bow-tie structure had to be greater than that of the amplification structure. This is why in the current design
the length of the flexures are small (so more rigid links are needed) in the bow-tie structure while the compliant
links in the upper amplification system are much longer. Also, because of the large deflections required for in
the upper amplification system, I was small while [ was large to reduce stress concentrations that could lead
to plastic deformation or early fatigue failure. Figure 4 shows an example flexure with the above variables.
Small-length flexural pivots were used in the design of the bow-tie structure.

I a iMﬁ
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Figure 4: Pseudo-rigid-body model of a small-length flexural pivot [Howell, Magleby, Olsen].

To verify the above design considerations, the optimization tool in ANSYS was used to generate multiple
experiments for the overall compliant structure. Although the structure was too complex to do full optimization
in a timely fashion, the results were used to make design choices.

Even after utilizing the design methods above, there are numerous possibilities for the loading and boundary
conditions of the flexure-based compliant mechanism. The structure exhibits different behavior depending on
which portions are more compliant. Using finite element software such as ANSYS can simplify the design
process by focusing on the important parts of the structure. As the actuator is designed to be part of the bullet
structure instead of a separate component, simulation time can be saved by isolating the actuator and taking
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the other, more rigid sections of the bullet structure into account by applying the appropriate boundary
conditions (shown later).

Preliminary FEA in ANSYS Workbench with a piezoelectric extension showed that the above structure without
the lever arm at 20 V applied to the piezoelectric bulk stack had a vertical displacement of 0.25 mm with total
average horizontal placement of 13.1 pm, or an amplification ratio of 19.1. 120 V was not used as the structure
would have a chance to buckle (120 V would result in a fully engaged bow-tie structure, i.e. a rectangle) after
disengaging the piezoelectric actuator. A simple geometry calculation with a kinematic structure assumption
showed that the required spoiler deployment would have been feasible. However, when the lever arm, hinge
arm, spoiler, and loads due to the aforementioned CFD results were added, the current design did not meet its
spoiler deployment criteria. Currently, there is a 1.24 mm deployment with a maximum von-Mises stress of
485 MPa at a voltage of 24.31 V. This means that with the input of 0.295 mm by the bow-tie structure, the upper
amplification system alone had an amplification ratio of 4.2, and the total amplification ratio of the entire
compliant structure with a total displacement of the piezoelectric actuator at 25 pm was 496. The increased
voltage in this case was acceptable since the other parts of the compliant structure helped prevent the bow-tie
from reaching maximum deployment, which again could result in buckling. Although this exceeds the fatigue
strength, given the short lifetime of the bullet during flight, estimated to be about 1-2 sec, this is acceptable as
it does not undergo plastic deformation. Quasi-static FEA using structural steel for the compliant structure (as
spring steel fatigue data was not readily available) resulted in a strain lifetime of 9902 cycles, or 3.96 sec
lifetime if constantly actuated at 2.5 kHz. This lifetime was found for ANSYS demonstration purposes, but since
the fatigue strength for spring steel can be 650 MPa as stated above, it is possible that the current design has
infinite life. Higher flap deployments may be reached at higher voltages, but it was observed that increasing the
voltage would result in a much shorter life for the compliant structure and increase the chances for the bow-
tie structure to buckle. Using actual spring steel with full elastic properties as intended, including fatigue, may
result in a higher lifetime. Figure 5 show the idle and engaged compliant structure with the boundary
conditions used to model the rest of the more rigid bullet structure. The results are summarized in Table 3.

LiSUu i Drag force
(adjusted bulk voltage) &~

—— | — Zero displacement

S

Zero displacement
ov

Figure 5: Piezoelectric stack actuator with compliant structure. Left: Idle. Right: Engaged.

Table 3: Summary of important results at 24.31 V.

Sp°“e.r End Max1m_um Cycles to Fatigue Failure Cycles to Fatigue Failure
Vertical von-Mises (Structural steel) (Spring steel)
Displacement Stress pring
1.24 mm 485 MPa 9902 cycles Infinite (theoretically)

It is possible that if the compliant structure’s natural frequencies were turned to the actuation bandwidth, a
greater displacement may be achieved. However, this is beyond the scope of this project and report. To better
visualize the rest of the bullet structure simulated using boundary conditions, Figure 6 shows a potential cross-
section and exploded view of the smart bullet as conceptualized by the author.
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Center Inner Bullet Structure
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Center Inner Bullet Structure Left Part of Inner Bullet Structure

Piezoelectric Stack Actuator /
-

Copper Bullet Jacket

Right Part of Inner Bullet Structure

Figure 6: Conceptual smart bullet sans electronics and weights.

Top: Cross-sectional view. Bottom: Exploded view.

The above would require very precise machining. EDM or laser micromachining should be investigated. These
manufacturing techniques may be costly, but given the rarity of using a smart bullet and the high-risk situations
itmay be used in, they should not be rejected. It should be noted that screw holes and screws were not modeled
for simplicity, but they would be located at the thicker sections of the right, center, and left parts of the inner
bullet structure. It should also be noted that most bullets are largely made of lead. The hollow nature of the
smart bullet will affect flight and impact characteristics, and weights should be added to compensate.
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Concluding Remarks

A solid-state smart actuator was designed for the purpose of engaging a spoiler on 0.50 caliber smart bullet.
Although it does not undergo plastic deformation under the applied voltage and will survive a typical lifetime
of a sniper bullet, the current design did not meet deployment requirements, reducing the possible total
absolute change in flight trajectory. The lessons learned from the wind tunnel testing and structural finite
element analysis can be applied for further verification and development. However, the methods and results
are promising. The model can be further tuned to meet specifications, and a solid groundwork has been laid for
future work done on the smart bullet project. Further work can now be done on multi-physics modeling, power,
flight characteristics, impact characteristics, mass properties, configuration, tracking, and controls.

The author would like to direct attention to the Appendix, which offers other possible solutions to designing a
smart bullet actuator.
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Appendix

Personal Statement of Contribution

In the fall semester of 2013, I reported mainly to Boris Kogan, who had the general oversight and knew the
progress of the project at that time. I also attended all lectures of Professor Garcia’s MAE 6950 (Special Topics)
course on smart materials to gain the background necessary to design smart actuators. I explored using Abaqus
(prior to entering Cornell, [ was proficientat Abaqus), COMSOL, and ANSYS for piezoelectric analysis, and chose
ANSYS because it was widely used in LIMS and ANSYS Workbench was the easiest to use of the three. Choosing
ANSYS would make future work more convenient. I familiarized myself with ANSYS and found ways to
incorporate piezoelectric analysis into structural FEA, something that no one in LIMS had experience in. I
explored using ANSYS Mechanical APDL and the recently released piezoelectric ACT extension for Workbench,
Piezo, and found that using the extension in Workbench was easier, more efficient, and equivalent to using
APDL. I also verified the Workbench results by looking at a mock scissor-jack actuator and verifying the
extension’s capabilities. The main conclusions from my investigations were that due to the elastic and
piezoelectric properties of the stack actuator, applying displacements alone (replacing the stack actuator) to
the compliant structure in ANSYS was not enough to provide results. Likewise, applying displacement signals
for transient purposes were not sufficient as it did not accurately describe the behavior of the smart actuator.
Lastly, my investigations found that the steel compliant structure’s response (engagement and disengagement)
to the stack actuator with a voltage signal was near instantaneous. These conclusions substantiated using
ANSYS Workbench instead of APDL as a key tool for designing the smart actuator for LIMS’s purposes, saving
time for future students working on the project who have little or no prior experience using APDL.

During winter break, I researched on compliant mechanisms and drew potential topological designs for smart
actuators that could be used for Gurney flap and spoiler deployment. I also realized that the previous model
designed (I was not involved with the design) in the fall semester was incorrect, prompting full redesign in the
spring semester.

In the spring semester of 2014, I took over the project since Boris departed from LIMS. I reported mainly to
Professor Garcia and led the team, which consisted of Lisa Li, Christina Middleton, and me. Using the knowledge
I had gained the previous semester, I took control of designing the compliant structure, and advised Lisa on
engineering design and building intuition. I instructed her on which design options to explore. I also oversaw
exchanges between Christina and the wind tunnel personnel at Syracuse University, as the wind tunnel testing
had to be redone (still in progress at the time of this writing). Lastly, we presented our work at the AIAA Region-
I Student Paper Conference at Cornell on April 25, 2014. I wrote most of the paper and created most of the
presentation slides, which in total took two weeks of preparation. On a side note, I attended the on-campus
ANSYS workshops in April to learn more about tools that could aid in designing the actuator.

Currently, all files related to the smart bullet project are being reorganized on the LIMS NAS server, and [ am
in the process of writing a short document describing the progress of the project so far. This is done so that
should the project continue, people can be easily brought up to speed. Since [ took MAE 6780 ( Multivariable
Control Theory) this spring,  am also working on a project that builds on Boris’s work on smart bullet controls,
utilizing a constrained Model Predictive Control with the Multi-Parameter Toolbox in MATLAB, hopefully
providing an explicit control law that does not require online optimization. This project might also explore
white noise disturbance (to simulate wind) rejection. All files regarding this project will be on the LIMS NAS
server.

Finally, I am in the process of creating a tutorial for modeling piezoelectrics in ANSYS Workbench, which will
be on Cornell Simcafe so that others can learn what [ have learned.

It is my hope that I have laid the groundwork necessary to facilitate future work on the smart bullet project.
Any question regarding the design of the smart actuator and this report can be emailed to ckc73@cornell.edu.
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533l maN 1,006E-11]  caal Nime 1,220E+11
=560 maN 2533E 11 o550 Nim® 3.040E+ 10|
5120 maN 7 G60E-12] 12D NimE 8,345+ 10
s1a0 maN Zo46E-12]  cial Nime 5,720+ 10
5440 maN 2532E-11]  c44D Nim® 3,848E+ 10
s660 maN 4,319E-11]  coeD Nim® 2,315E+ 10

Values are only for informaton - no specification!
Simulaficn purposa

The data in the table was determined using test bodies with geometries and

dimensions in accordanca with European Standard EM 50324 2, and are typical values.

Singular parametars can deviale from catalogue values, because they wem maasured
at samples which were taken from one block of caramics according to the seguence
of IEC483 to get maximum consistancy.
Catalogue values reflact the statistical distribution of each individual specification in
producticn and tharefore alzo take info account spraading from material batch to

material batch.
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Fall Semester Investigations

A summary of my investigations in the fall can be found in the “Statement of Personal Contribution” section
above.

The below table shows the equivalent conversions for modeling piezoelectric stacks in ANSYS. This was
obtained from the official blog of ANSYS (http://www.ansys-blog.com/multilayer-piezoelectric-actuators-can-

single-layer-modeled-simulate-layered-stack/).

Single Multi-layer Bulk Ratio
Layer Stack (Bulk/multi-
layer)
v V;
Input Voitege V.= f Vy = ;b V, = nV, n
Electric Vg Vum Vs W
=S = Ep=—=
Field Es=tn Em=4, b= 1, nxth 1
Strain e=d:Ey &y =d.Ey & = d.E, 1
R AL =ths, |AF = AL = th.e; "
=th.d.E, |~ ™"t =n.th.d.E,
Output =nith.d.Esy
L Electric Flux
quantities Density D, =« E, Dy = x.Ey Dy, = «E, 1
(E:f::;:Q %104 gMn Dy A G = Di:A ol
= - : M‘ = -
xE. A — n.x.Ey. A xEy.A (5 S )
Capacitance KA KA kA kA Cp 1
C Cs=th Cs=Mn P 1i nith c; n?

Calculations were done to compare ANSYS results for the piezoelectric stack. For a stack:

ds3L
60= 33 3V
t
fou =V
bl S3E3tp

Given:
Vigyer =120V, A=5mm x5 mm, L; =36 mm, t, = 0.05 mm
d33 = 3.94’E'10 m/V

Calculated:

LT3 = Vouie = Vigyer ¥ = 72000V

sk = dyy By, By = 2% = 3333.33V/m

3

n =
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Piezoelectric stack static modeling ure below are in mm):

Results
Given Calculated ANSYS ANSYS Error | ANSYS Error
from Calc. from Given
Free disp. (um) 38+10% 34.04 28.281 -16.9% -25.6%
Blocked force (N) 950 1127.32 936.52 -16.9% -1.4%

The following can be done to adjust the model:

e = YEd is used for ANSYS input. Y5 = SLE (or Young’s modulus in the 3-3 direction) should be increased for
33

new ANSYS input, as increasing voltage will not adjust for both blocked force and free displacement
accordingly. d;5 can then be changed using the blocked force equation. This can be an iterative process to
provide a more accurate model if desired.

Example Mock Scissor Jack Actuator:

0 V or Displacement Signal
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Modal Analysis

The table below demonstrates modal analysis while using the Piezo extension. Due to time constraints, this was

not done for the actual actuator discussed in the technical report above.

Frequency Frequency
(Hz) (Hz) with
without : Mode
. piezo
piezo roperties
properties P
1625.7 1652.3
1815.5 1830.8
5868.5 5875.8




7838.4 7980.8

9310.7 9587.3

10245 10601

The differences in the two sets of frequencies showed that the piezoelectric properties could not be ignored in
modal analyses.
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Transient Analysis (displacement function and voltage signal)

This analysis was done to compare using a displacement signal versus a voltage signal.

At 2500 Hz,
72000Volts T 72000V olts
V(t) = —51n(2500 - 2mt — —) +—
2 2
38um T 38um
x(t) = 5 sm(2500 - 21t _E) + 5
This gave the following plot:
Displacement  of compliant structure top (y m)
; - ; - t(sec)
0.0002 0.0006
- 2 L
-4 Displacement Signal
Y Voltage Signal
-8l
-10+
- 12L

As can be seen above, using a voltage signal results in a more conservative model. This is also more realistic
because the piezoelectric stack has elastic properties that must be taken into account.

Miscellaneous information about the mock scissor-jack actuator above using piezoelectric static structural
analysis were as follows:

Max horizontal displacement: 8.21 pum
Max vertical displacement: -9.45 pm

Amplification: 1.15 x

Likewise, transient analysis was not explicitly done with the actuator discussed in the technical report due to
time constraints.
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Attempted Iterations and Comments

It is my hope that this section helps provide a “lessons learned” account on designing the compliant structure.
This and the technical report should give the full picture.

The first three iterations all utilized small-pivot flexures except for the link connecting the spoiler to the bullet
structure. The first attempt (shown below) was ultimately used for the AIAA student conference. This iteration

was given two months in the spring semester to complete. Many adjustments were done to the model to test
its potential.

————

/ Ground

The bow-tie structure alone had the same vertical displacement as the current design, and simple geometric
calculations given a kinematic structure predicted that a 2 mm deployment would be reached. However, this
was not the case. It reached 0.67 mm vertical spoiler displacement and had a maximum von-Mises stress of
1133 MPa. Upon closer inspection of the upper amplification structure (below), the problem was clear.

Zero Displacement




Due to the very short length of the flexure in the lever arm, in which both ends used the small-length flexural
pivot, there was a high torsional stiffness, this resulted in the high stress concentrations (shown in red above).
It was also observed that the link connecting the spoiler to the simulated inner bullet structure (shown as a
cube-like structure above) was very compliant and long. This resulted in less of a mechanical advantage from
the lever arm to the spoiler and more resistance against angular rotation of the spoiler. Instead, the flap mainly
translated vertically. However, these conclusions were reached after the second and third attempts were done.
[ would advise that using small-length flexural pivots for a lone lever arm connecting the bow-tie structure to
the spoiler should be avoided unless an alternate upper amplification structure is found to be successful. The
advantage of using the small-length flexural pivots is the resistance to disturbances or large aerodynamic
forces, and the disadvantage, again, is the high stress concentrations.

The second attempt, given a week to explore and was done two weeks before the AIAA student conference,
utilized the following ball and stick model:

The idea for this was obtained from the Handbook of Compliant Mechanisms, shown below:

\

1. stage

L.,

input
\C N e “—
Thin elastic
beams
n” k\
2. stage J
d
(r 5
..-",,"\l = < € - &
b Thick rigid beams

(1) (2)
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Due to time constraints, this model was not fully explored, but reached similar numbers to the first attempt. [
recommend that more investigations be done on this as the overall greater torsional stiffness will have a
stronger actuator, and with the right dimensions, should reduce stress concentrations.

The third attempt used a double-lever system, which looked like a double-flap system. As a kinematic structure,
this should have provided the greatest amplification ratio of all attempts. This was explored the week before
the AIAA student conference.

The results were worse than the second iteration. However, given the new upper amplification system of the
current design, this should be explored again in the future. It is important to note that the torsional stiffness of
the lower half of the upper amplification system should be greater than that of the upper half, yet less than the
torsional stiffness of the bow-tie structure in order to maximize amplification.

The current model uses the following upper amplification structure:

Using the lessons learned above, the current greater deployment and lesser maximum von-Mises stress were
reached. This allowed greater rotation of the spoiler while reducing stress concentrations.
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Additional Compliant Mechanism Plans, Solutions

The following scan shows other possible ball and stick models with advantages and disadvantages of each.
These were done before anything was modeled in SolidWorks and ANSYS. These sketches allowed for both
Gurney flap and spoiler deployment. However, it should be noted that any dual deployment system should

deploy and retract 90° apart from each other about the spin axis of the bullet as well as oscillate 180° out of

phase with each other.
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Should there be insufficient room in the smart bullet for other components, an octagon lower amplification
structure with a smaller piezoelectric stack (such as a 5 mm x 5 mm x 18 mm stack) rather than a bow-tie
structure should be investigated. Utilizing the above methods and learned lessons should facilitate the design
process. This will also result in a simpler design because symmetry may be used. Below shows the ball and
stick model for such a design:

fAy

AR
NN

¥

Using the same notation as the technical report, the equations describing the kinematic structure are

8o = €(cosf —cosB")
Ay = £(sinf' — sin9)

Note that once again, the top and bottom center links do not contribute to the above equations. The above
results in an optimal angle of

_1 9%
B,p¢ = COS 1ﬁ

Should the preliminary CFD analysis and current actuator design not practically work due to larger
aerodynamic forces than expected, then a hybrid actuator should be considered. This hybrid actuator should
utilize a primary compliant structure to amplify the piezoelectric stack actuator, but utilize hinges to deploy
the spoiler. It should be noted that this no longer becomes a fully solid-state actuator. For example, the hinges
can be located at the top of the compliant structure (if using a bow-tie or octagon), the bottom of the spoiler
(near the front), and at the front face of the spoiler connecting the spoiler to the rest of the bullet. A connecting
arm can connect the hinge at the top of the compliant structure to the hinge at the bottom of the spoiler. This
should allow for a larger torsional stiffness to be designed in the compliant structure, resulting in a stronger
actuator. The elastic properties of the compliant structure, aided by aerodynamic forces, will restore the spoiler
to a disengaged position. The figure below demonstrates this example:
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L

Spoiler

Hinges

+

Rest of Bullet Structure

Connecting Arm

Top of Compliant Structure

LI

(etc.)

Should a more capable piezoelectric actuator be needed, a single-crystal piezoelectric actuator can be
considered. Single-crystal actuators can withstand higher voltages than stack actuators, and this results in
higher deflections. Estimates from TRS Technologies give the following information on their single-crystal

piezoelectric actuators:

— Approximate Maximum Estimated Maximum . .
Description Voltage Stroke (um) Estimated Price
3
SX5x36 mms, 0.5 mm 500V >>35um $3,640
plates
3
5x5x18 mm3, 0.257 mm 260 V 5> 16 um $3.400
plates
3
5x5x18 mm3, 0.5 mm 500V >>18 um $2.510
plates

TRS stated that the strokes were estimates. Theoretically, they would be even larger. However, since the
actuators are clamped and the performance is reduced due to the stacking of the layers and the epoxy, the exact
impact was difficult to calculate. Their PMNT29 material has the following properties:
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MEASURED AND DERIVED ELASTIC COMPLIANCE CONSTANTS, 5, (10 m*/N). AND ELASTIC STIFFNESS CONSTANTS,
¢; (10 N/m®), FOR PMNT29

. E E E E E E D D D D D D
Material S S S1i3 Si Sy Ses Sy 513 513 S3i3 Sy e
PMNT29 521 -246 -264 599 160 283 418 -348 -39 103 140 283

. E E E E E E D D D D D D
Material ST (5T €13 C33 Cyq Cas (&% (&5 €13 C33 Cys Ces

PMNT29 124 111 104 108 6.3 35 126 113 9.3 168 7.1 3.5

TABLE II. Piezoelectric Coefficients. d; (pC/N), ey (C/m®). gy (10°Vm/N), hy; (10*V/m). and Electromechanical
Coupling Factors, k;, For PMNT29

Material ds3 ds; dis £33 €31 €15
PMNT29 1540 -699 164 223 -39 10.3
Material o33 251 o1 hss hs hys
PMINT29 322 -14.6 119 277 -48 87
Material ka3 ks; kis ke k3 (45°C)
PMNT29 091 044 0.35 0.60 0.81

Dielectric Constants, g (eg). and Dielectric Impermeability Constants,
B (107e,), For PMNT29

orial T T 5 5 T T 5 5
Mat £33 & £33 & B Pu B B

PMNT29 5400 1560 910 1340 1385 641 1099 746

* Ec: 1.8-3kv/em, Trt: 80-100°C

The people to contact at TRS Technologies would be Jenna VanLeeuwen (jenna@trstechnologies.com) or Raffi
Sahul (raffi@trstechnologies.com). Refer to the project as the “Cornell smart actuator project” when
communicating with them.
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ANSYS Workbench Piezoelectric Tutorial

This ANSYS tutorial provides the steps needed for a quasi-static structural analysis of the actuator discussed in
this report. The files needed can be found on the LIMS NAS server. This tutorial assumes some familiarity with
ANSYS Workbench and that the piezoceramic PIC255 from PI is used.

1.

5.

Download the Piezo extension for ANSYS 14.5 or 15 from the ACT Extension Library of the Customer
Portal
(https://support.ansys.com/AnsysCustomerPortal/en_us/Downloads/Extension+Library/ACT+Libr
ary).
Install from the Workbench Project page.

a. Select “Extensions” -> “Install Extension”

b. Select the *.wbex file when the file explorer window opens.
Open the project file “SB_Actuator.wbpj”.
Under material properties, check that material PIC255 is there with the following material properties
(which can be found on the PIC255 datasheet above). If not, add it to the library.

A B C D E F
1 5] I Pl 25 Rl (0 251 Sl 25 2 ) | 25 g
b 1,23E+11
3 7.67E4+10 1.23E+11
4 7.025E+10 | 7.025E+10 | 9.711E+10
5 0 0 0 2.226E410 | 7730
& 0 0 0 0 2.226E410
7 0 0 0 0 0 2.315E410

The density of PIC255 should be set to 7800 kg/m3.
Part of the workspace should have the following modules:

- N

- Q
1
2 m Geometry " 2 @ Engineering Data  +"
Geometry —\l3 Bl Geometry 4
4 ﬁ Model

./
W

5 @ setup v
v
./

I8 . Geometry

6 ‘.‘E Solution
7 @ Results
8 |[pd Parameters

FINAL WITH UPPER AMP

The module on the right is a renamed Static Structural module. If the assembly file is open in
SolidWorks, the geometry can be updated by right-clicking the “Geometry” box on the left with the
SolidWorks icon and selecting Update from CAD. Note that there is a “Parameters” box. Any SolidWorks
dimension labeled with “DS_" as a prefix will show up as a parameter in ANSYS which can be adjusted
or optimized. For a tutorial on using the optimization tool, see the “Plate with a Hole: Optimization”
example on the Cornell ANSYS Simcafe website.

After clicking on the “Model” box. On the left, you should be able to see the following (or some variant
of it):



Project

= Model (04)

+¢fﬁ Geometry

--,r,;vi,:. Coordinate Systems
(Jij Connections

- /0 Mesh

=--[2] static Structural (05)
iy Analysis Settings

/@ Bottom
JE‘L Bullet Suppart Sim
« Drag Force
jg Piezoelectric Body
Applied Voltage
Ground
B+ Solution (06)
_;|I| Solution Information
_;:ﬁ Equivalent Stress
- W Back
_;ﬁ Front
_;ﬁ Directional Deformation
: Strain Life
_//Qil Spoiler Aft
-/’Ql Spoiler Front
Bow-tie Top

7. Go to the Analysis Settings and ensure that the following is set:
Details of "Analysis Settings”

-|| 5tep Controls

Number Of 5teps 2.

Current Step Number | 1.

Step End Time 1.5

Auto Time Stepping | Program Controlled
-| Solver Controls

Solver Type Direct

Weak Springs Program Controlled
Large Deflection Off

Inertia Relief Off

+|| Restart Controls

+|| Nonlinear Controls

+ | Qutput Controls

+|| Analysis Data Management
+| Visibility

There are 2 steps for allowing the actuator to fully engage and then applying the drag force. It is
important that the Solver Type is “Direct” to allow for very small deflection modeling. Setting it to anything

else will cause the model to fail.

8. Select “Piezoelectric Body” and check that the following is set:

Notice that the polarization axis is in the Z direction. Make sure that the actuator poling direction (or
bullet’s spin axis) is aligned along the Z direction. If not, the results will be inaccurate. Select the

piezoelectric stack as the designated body.
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Details of "Piezoelectric Body"

=

Scope

Scoping Method Geometry Selection
Geometry 1 Body

Definition

Polarization Axis Z

Permittivity Constant

8.854E-12 [A A sec sec sec sec kg™-1 m™-1 m~-1 m*™-1]

PIEL 231

-7 15 [Asecm™-1 m™-1]

PIEZ e33 13.7 [A sec m -1 m#-1]

PIEZ 215 14,46 [A sec m®-1 m™-1]

DPER ep11 1650

DPER ep33 1750

RSWX OkgmmmAn-1 AT sech-] sect-1 sech-1)
RSWVY Okgmmma*-1 4% sech -] sec™-1 sech-1]
RSWVZ OkgmmmAs-1 AT sech-1 sec™-1 sech-1]

0 0.01 0.02 ()
0.005 0.015
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9. Going down the list of boundary conditions, ensure that the following is set and/or selected:

a. Bottom

Note that zero-displacement boundary conditions are used instead of fixed support. Using
fixed supports as boundary conditions in ANSYS will cause the Piezo extension to malfunction.

Details of "Bottom”

[=l| Scope
Scoping Method Geometry Selection
Geametry 1 Face

[=I| Definition
Type Displacement
Define By Components

Coordinate System

Global Coordinate System

¥ Component

0. m [ramped]

Y Component

0. m [ramped]

Z Component

0. m (ramped]

Suppressed

Ma

b. Bullet Support Sim

Details of "Bullet Support Sim”

[-I| Scope
Scoping Method Geometry Selection
Geaometry 1 Face

[=I| Definition
Type Displacement
Define By Components

Coordinate System

Global Coordinate System

¥ Component

0. m [ramped]

¥ Component

0. m [ramped)

Z Component

0. m [ramped]

Suppressed

Mo

0.01 (i)
]
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c. DragForce

Note that the -2.67 N is from the CFD preliminary analysis.

=

Details of "Drag Force” o
Scope
Scoping Method | Geometry Selection
Geometry 1 Face
Definition Tabular Data
Type Force Steps | Time [s] |[v % [N] [[v v [N][]v Z[M]
Define By Components 11 0. 0. 0 0.
Coordinate system | Global Coordinate System 2|1 1 0. 0. 0.
[ ¥ Component |0.N [ramped) 3|2 2 =0 =0 -2.67
| ¥ Component | 0. M [ramped) *
Z Component Tabular Data
Suppressed Mo

0

0.0025

0.005
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d. Applied Voltage
Note that this is the adjusted bulk voltage. Make sure that the stack face is selected, not the
larger face of the compliant structure that is in direct contact with it.

- “Applied Voltage" 7

[=]| Scope
Scoping Method | Geometry Selection
Geometry 1 Face

[=I| Definition

Time Dependency | Mo
Voltage [Real} 17500 [kg m m A*-1 sect-1 sech-1 sech-1]

Q 0.005 0.01 (rm)
I . )
0.0025 0.0075
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e. Ground
This is very similar to the applied voltage boundary condition. If the simulation gives a
nonsensical behavior, specifically if the actuator acts in the opposite direction, switch the
locations of the Applied Voltage and Ground boundary conditions.

ils of "Ground" o
[<I| Scope
Scoping Method | Geometry Selection
Geometry 1 Face
[=| Definition
Time Dependency | No
Voltage (Real) 0 [kg m m A%-1 sech-1 sech-1 sech-1]

0 0.005 0.01 (rm)
| —
0.0025 0.0075

10. Under the Solution section, Equivalent Stress should be selected for only the compliant structure
(although all bodies are accepted), Back should have the same face selected as Applied Voltage, and
Front should have the same face selected as Ground.

11. Directional Deformation should have an X-axis orientation. All bodies are accepted.
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12. Spoiler Aft and Spoiler Front should be selected as such as the top back edge of the spoiler (shown
below, left) and the top front edge of the spoiler (shown below, right), respectively. The edges are
highlighted in green. The lower the front displacement, the more aerodynamic the spoiler is.

Use the same settings for both:

Details of "Spoiler Front™

[ Definition
Type Deformation
Location Method | Geometry Selection
Geometry 1 Edge
COrientation Global Coordinate System
Suppressed Mo
[=I| Options
Result Selection | X Axis
| | Display Time | End Time
Spatial Resolution | Use Maximum

[+]| Results
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13. Bow-tie Top should have the top face of the compliant structure selected, and like before, the X-axis
should be selected as the orientation.

0 0.005 0.01{m)
I . )
\m 0.0025 0.0075
~

14. If Strain Life (or “Fatigue Tool”) does not show under Solution, right click Solution, then click Insert ->
“Fatigue” -> “Fatigue Tool”. Click Strain Life (or “Fatigue Tool”) and make sure that “Strain Life” is
selected for the analysis type. Strain Life can be used for low and high cycles, whereas Stress Life is
used for mainly high cycles. Make sure the piezoelectric stack is not selected as one of the bodies for
“Life” and “Safety Factor.” Similarly, these can be selected as solutions if Strain Life (or “Fatigue Tool”)
is right clicked. Then, select Insert -> “Life” or “Safety Factor.” Ensure that the following setting for
Strain Life (or “Fatigue Tool”) is used:

[=I| Materials
Fatigue Strength Factor (Kf) |‘I.
[=I| Loading
Type Fully Reversed
| | scale Factor 1,
[=1| Definition
|| Display Time End Time
[=I| Options
Analysis Type Strain Life
Mean 5tress Theory SWT
Stress Component Equivalent [Von Mises)
Infinite Life 1.e+009 cycles
[=1] Life Units
Units Mame cycles
1 cycle is equal to 1. cycles

15. Ensure that the mesh is fine enough. Refinements may need to be done at the flexure edges. The thicker
parts are rigid enough; the mesh does not have to be fine there.

16. Click Solve.

17. Observe results under “Solution.”
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